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Developing Plugtin Programs

E—

In this chapter. ..

“Understanding plug-in programs” on page 534
“Using the API documentation” on page 535
“Developing plug-in programs” on page 543

“Creating a self-contained plug-in frame” on page 557

Users who know how to program in Java can write a plug-in program that
adds support for a new file format, creates a new view, or applies a new
algorithm to an image. This chapter does not intended to explain how to
write a Java program; rather it presents information to help users who
are writing plug-in programs to customize MIPAV. You can find in this
chapter how to:

¢ Gain access to and use the online MIPAV application programming
interface (API) documentation

e Determine which version of Java to use

¢ Select one of the three plug-in types

¢ Include mandatory lines of code in plug-in programs so that they
interface correctly with MIPAV

e Install plug-in programs
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Understanding plug-in programs

Plug-in programs, also known simply as plug-ins, are utilities or sets of
instructions that add functionality to a program without changing the pro-
gram. In MIPAV, you use Java to write and compile plug-in programs to
perform specific functions, such as automatically removing all odd-num-
bered images from the image dataset or adding support for a new file for-
mat. There are three types of plug-in programs that you may write for
MIPAV:

¢ Algorithm—An algorithm type of plug-in performs a function on an
image. An example is a plug-in that applies a radial blur algorithm to
an image. You can create plug-in algorithms through Java.

¢ File—A file type of plug-in allows MIPAV to support a new file format.
An example is a plug-in that allows MIPAV to view Kodak Photo CD
files (.pcd).

e View—A view type of plug-in introduces a new view, or the way in
which the image is displayed. Examples include the lightbox, triplanar,
and animate views.

Note: Because MIPAV already supports a large number of file formats and views
and its development team makes it a practice to extend its capabilities in these
areas, it is generally unnecessary to add file or view types of plug-ins. Most plug-
in programs, therefore, are algorithms.

After developing a plug-in program, you can then install the plug-in pro-
gram into the MIPAV application and access it from the PlugIns menu in
the MIPAV window. The MIPAV window labeled “(A)” in Figure 318 shows
the Plugins menu as it appears before any plug-in programs are installed.
The picture labeled “(B)” in Figure 318 shows the PlugIns menu as it
appears after two plug-in programs—in this case, the Fantasm plug-in pro-
gram and the Talairach Transform plug-in program—are installed. Because
the Fantasm and Talairach Transform plug-in programs are algorithms,
they appear under the Pluglns > Algorithm menu.

MIPAV User’s Guide, Volume 1, Basics 534
12/2/08



MIPAV User’s Guide, Volume 1, Basics

aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa

Note: If a plug-in program is a file type of plug-in, it would appear under a
PlugIns > File menu. If it is a view type, it would appear under a Pluglns > View
menu.

:F;ﬂMedical Image Processing, Analysis & Yisualization {MIPAY)

File |Plugins | Scripts  Help
Install plugin

MIFAY Mernory usage: 400 /7950 ;?'_.
a
:F;ﬂMedical Image Processing, Analysis & Yisualization {MIPAY)
File |Flugins | Scripts  Help
o 1 M C dLineTest
Install plugin DTIColoxrDisplay
MIFAY Mernory usage: 400 /7950
b

Figure 318. Plug-ins menu in the MIPAV window: (a) Before a plug-in was installed and (b) after
two plug-ins were installed

Using the API documentation

Documentation for the application programming interface (API) is located
on the MIPAV web site <http://mipav.cit.nih.gov/>. You can use the docu-
mentation directly on the web site. However, if your internet access is lim-
ited or slow, you can download, install, and use either a zipped version of
the documentation on a Windows workstation or a tar version on a UNIX
workstation.

To access the API documentation via the internet

1 Go to the MIPAV web site:< htip://mipav.cit.nih.gov/>.

2 Click Development in the links on the left side of the page. The
Development page appears. See Figure 319.

3 Here, use the following links: MIPAV API and MIPAV XML based
Formats.
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Figure 319. The Development page on the MIPAV web site offers a lot of
helpful links

TO DOWNLOAD AND INSTALL THE API
DOCUMENTATION ON A WINDOWS
WORKSTATION,

1 Under Documentation for download, select a zip-formatted
version. Save the file to a directory of your choice.

2 Go to the directory, double-click api.zip, and extract the files.
Extraction creates a directory named “api” under the directory you
chose to place the files.

3 Open the api directory, and double-click index.html. The API
documentation appears in your browser.
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TO DOWNLOAD AND INSTALL THE API
DOCUMENTATION ON A UNIX WORKSTATION,

1 Under Documentation for download, select a tar.gz-formatted
version. Save the file to a directory of your choice.

2 Go to the directory, double-click api . tar.gz, and extract the files.
Extraction creates a catalogue named “api” under the directory you
chose to place the files.

3 Open the api directory, and double-click index.html. The API
documentation appears in your browser.

Viewing MIPAV API documentation online

On the Development page, click the Application Programming Interface
JavaDoc link <http://mipav.cit.nih.gov/documentation/api/index.html>.
The API documentation page appears displaying the following three frames:

¢ Top left frame—Shows all of the Java packages for the MIPAV
application. When you select the All Classes link at the top of this
frame, all of the classes in MIPAV appear in alphabetical order in the
bottom left frame. If you select a particular package, the bottom left
frame displays only the classes that pertain to the selected package.

¢ Bottom left frame—Lists either all of the classes in the MIPAV
application or all of the classes in a selected package.

¢ Right frame—Displays information based on the command that you
select in the menu at the top of the frame:

e Overview—Lists all of the packages in the MIPAV application

¢ Package—Lists and summarizes all of the classes and interfaces in the
package

¢ Class or Interface—Lists descriptions, summary tables, and detailed
member descriptions

¢ Tree—Displays a hierarchy of the class or package

¢ Deprecated—Lists deprecated APIs
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¢ Index—Provides an alphabetical list of all classes, interfaces,

constructors, methods, and fields

¢ Help—Provides help for the API documentation

Several links appear beneath the menu.

¢ Prev and Next—These links take you to the next or previous class,

interface, package, or related page.

¢ Frames and No Frames links—These links show and hide the
HTML frames. All pages are available with or without frames. See

Figure 320.

B

dex.html v[>I

) Medical Image Processing, s ) ‘ ® o

Ay AP o... G |

All Classes j

gav.nih mipav
gov.nihmipav mod
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I Package Class Tree Deprecated Index Help
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gov.nih.mipav.mod

gov.
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gov. model.algorithms filters
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gov.nih.mipav. mf'ﬂ

v.model.algorithms.levelset

gov.nih mipav.mo: =
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AlgorithmOptimizef,

lasses

C
AlgorithmAGVE p— - "
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AlgorithmConstPow
AlgorithmConstPow

Figure 320. The Overview page

OVERVIEW PAGE

The Overview page is the page that initially appears when you gain access to

the API documentation. This page displays a list of all of the packages in

MIPAV. The Overview menu becomes available after you move to another

page. To return to the Overview page from the any other page, click
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Overview. The Overview page appears and displays a list of all of the
packages in MIPAV.

PACKAGE PAGE

When you select one of the packages listed on the Overview page, the Pack-
age page appears. This page provides a summary of each interface (if any),
class, and exception (if any) in the package. When you click an interface or
class, the Interface page or the Class page appears. Clicking an exception
displays the Exception page. See Figure 321.

INTERFACE OR CLASS PAGES

When you select an interface or class on the Package page, either the Inter-
face page or the Class page appears. Each interface, nested interface, class,
and nested class has its own separate page. Each of these pages has three
sections consisting of an interface or class description, summary tables, and
detailed member descriptions:

e Class inheritance diagram

¢ Direct known subclasses

e All known subinterfaces or subclasses
¢ All known implementing classes
e Interface or class declaration

¢ Interface or class description

¢ Nested class summary

¢ Field summary

e Constructor summary

e Method summary

e Field detail

e Constructor detail

e Method detail
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Each summary entry contains the first sentence from the detailed descrip-
tion for that item. The summary entries are alphabetical, while the detailed
descriptions are in the order they appear in the source code. This preserves
the logical groupings established by the programmer. See also Figure 321.

Note: Each serialized or externalized class has a description of its serialization
fields and methods. This information is of interest to re-implementors, not to
developers using the API. To access this information, go to any serialized class
and clicking Serialized Form in the See also section of the class description.

EXCEPTION PAGE

The Exception page appears when an exception on the Package page is
selected. This page includes a constructor summary and constructor detail.

TREE (CLASS HIERARCHY) PAGE

When you click Tree on the menu, a Tree, or class hierarchy, page appears.
This page displays either the class hierarchy for a particular package, or, if
you select All Packages, the class hierarchy for all packages. See Figure 321.

¢ If you were viewing the Overview page and then clicked Tree, the class
hierarchy for all packages appears on the Tree page.

¢ If you were viewing a Package, Interface, Class, or Exception page and
then clicked Tree, the hierarchy for only that package, which includes
the class, interface, and exception hierarchies, appears on the Tree

page.
Each hierarchy page contains a list of classes, interfaces, and exceptions (if

any). The classes are organized by inheritance structure starting with
java.lang.Object. The interfaces do not inherit from java.lang.Object.
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DEPRECATED API PAGE

The Deprecated API page appears when you click Deprecated on the menu.
This page lists all of the methods in the API that have been deprecated. A
deprecated method is not recommended for use, generally due to
improvements, and a replacement API is usually given.

Warning: Deprecated APIs may be removed in future implementations.

INDEX

The Index page provides an alphabetic list of all classes, interfaces,
constructors, methods, and fields with definitions of each. Clicking an entry
displays the usage in the product.

HELP PAGE

The Help page provides help for using the API documentation.
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Figure 321. The Package, Case and Tree pages of MIPAV API

TO DISPLAY,

All interfaces, classes, and exceptions in a package

1 Go to <http://mipav.cit.nih.gov/documentation/api/>. The Overview
page appears.

2 Click one of the packages listed in the:

¢ Frame on the right—When you click one of the packages listed on
this page, the Package page appears in the frame. The Package page
displays a list of all interfaces, classes, and exceptions (if any) in the
package.

e Top frame on the left—The top frame on the left also lists all of
the packages. When you select a package, the bottom frame on the
left displays a list of interfaces, classes, and exceptions (if any) in the
package.
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The methods associated with an interface or with a
class

1 Go to <http://mipav.cit.nih.gov/documentation/api/>. The Overview
page appears.

2 Do either of the following:

e Click one of the packages listed in the frame on the right or in the top
frame on the left. The Package page appears in the right frame.

¢ Click one of the packages in the top frame on the left. A list of
interfaces, classes, and exceptions appear in the bottom frame on
the left.

3 Do one of the following:
¢ Click an interface. The Interface page appears in the right frame.
e Click a class. The Class page appears in the right frame.

4 Scroll down the page, or click METHODS beneath the menu. The
Method Summary table appears.

5 Click a method. The Method Detail section of the page, which lists a
description of the method and its parameters, throws, and returns,
appears.

Developing plug-in programs

MIPAYV provides the following classes for developing plug-in programs:

¢ PlugInAlgorithm.class

¢ PluglnFile.class

e PlugInView.class
Plug-in programs are developed in the same way as the other Java programs
are. The high-level steps of creating plug-ins follow.

1 Determining the type of plug-in program—Before you begin to
write the code for the plug-in, determine the plug-in type: algorithm,
file, or view. Refer to “Determining the type of plug-in program” .

2 Determining which version of Java to use—Detailed instructions
appear in “Determining which version of Java to use” and Figure 322.
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3 Writing the source code—Some lines of code must appear in the
source code so that the plug-in program interfaces correctly with
MIPAV. Refer to “Writing the source code” .

4 Building and compiling plug-in programs—You should keep
back-up copies of the source and compiled files in case you need to
update or change plug-in programs. See “Building and compiling plug-
in programs” .

5 Creating a self-contained plug-in frame—A self-contained plug-in
is a Java application that does not rely on the default MIPAV user-
interface, but, instead, hides MIPAV and display its own image(s) with
action/algorithm handling specific to its frame. See “Creating a self-
contained plug-in frame” .

6 Installing plug-in programs—This section explains how to install
plug-in programs. Refer to “Installing plug-in programs” .

7 Sample plug-in programs—This section provides a couple of
examples of MIPAV plug-ins. Refer to “Examples of MIPAV plug-ins” .

Note: This section does not explain how to write a Java program; however, it
explains what must be incorporated in the plug-in program so that it correctly
interfaces with the MIPAV application.

Determining the type of plug-in program

The first step of creating a plug-in program is to determine the type you
want to create, which depends on its purpose. As mentioned earlier, MIPAV
plug-in programs can be of the algorithm, file, or view type. However, most
users want MIPAV to perform very specific additional functions on images.
Since these functions may not be currently available in MIPAV, users
choose to add the functions by developing the algorithm type of plug-in
program.

Determining which version of Java to use

To avoid compatibility problems when you create a plug-in program, use
the same version of Java that was used to create MIPAV. To determine
which version of Java the latest version of MIPAV uses, select Help > JVNM
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Information in the MIPAV window. The About System dialog box opens.
See Figure 322.

Ii;i] About System
HTava version: 1.5.0_1 |~
Java compilex: mall
Jawva wvendor: Sun Microsystems Inc.
Java vendor.url: http: //java. sun. com/
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Java class wersion: 49.0
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0% name: Tindows XP
03 arch: ®36
05 wersion: 5.1 =

Figure 322. About System dialog box

The first line in the About System dialog box indicates the version of Java
that was used to develop MIPAV. To obtain the correct version of Java, go to
the following web site: <http://www.java.sun.com>

Writing the source code

Note: In this section, \$MIPAV is used to represent the MIPAV user directory,
which is the directory where MIPAV is installed. The user directory is indicated in
the About System dialog box. In the MIPAV main window, select Help > JVM
Information to view the About System dialog box.

When you develop a plug-in for MIPAV, several lines must be present in the
code so that it executes properly. Some mandatory code should be included
in all plug-in files. Other code might change depending on the plug-in type.

INCLUDING MANDATORY CODE

The next three figures (Figure 323—Figure 325) show the mandatory source
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MAIEAY.
code needed for creating a file type of plug-in, a view type of plug-in, and an
algorithm type of plug-in. The plug-ins directory of MIPAV includes these
three files (e.g. C:\[$MIPAV]\mipav\plugins):
¢ PluglInFile.java—Mandatory source code for a file type of plug-in.
See Figure 323;
¢ PlugInView.java—Mandatory source code for a view type of plug-in.
See Figure 324;
¢ PlugInAlgorithm.java—Mandatory source code for an algorithm
type of plug-in. See Figure 325.
1 package gov.nih.mipav.plugins;
2
3 import gov.nih.mipav.view.*;
4
5 import java.awt.*;
6
7 public interface PlugInFile extends PluglIn {
8
9
10
11
12
13 public void run (ViewUserInterface UI);

14

}

Figure 323. Mandatory code for a file type of plug-in (PlugInFile.java). For readability purposes,
keywords in all code reproduced in this chapter appear in bold, and comments appear in green

type
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1 package gov.nih.mipav.plugins;

2

3 import gov.nih.mipav.model.structures.*;
4 import gov.nih.mipav.view.*;

5

6 import java.awt.*;

-

8 public interface PlugInView extends PlugIn {
9

10 /

11

12

13

14

15

16

17

18

19

20

21 public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image);
22 }

Figure 324. Mandatory code for a view type of plug-in (PlugInView.java). For readability
purposes, keywords in all code reproduced in this chapter appear in bold, and comments appear
in green type

package gov.nih.mipav.plugins;

import gov.nih.mipav.model.structures.*;
import gov.nih.mipav.view.*;

import java.awt.*;

O ~J o U b WN B

O

public interface PlugInAlgorithm extends PlugIn ({
10

11

12

13

14

15

16

17

18

19

20

21

22 public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image);
23

24

25 }

26

Figure 325. Mandatory code for an algorithm type of plug-in (PlugInAlgorithm.java). For
readability purposes, keywords in all code reproduced in this chapter appear in bold, and
comments appear in green type
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REFERENCING FILES
To reference a class, you must specify it using the Import keyword. For
example, line 2 in PlugInFile.java imports the view functions (Figure 326).
import gov.nih.mipav.view.*;
Figure 326. Importing the view functions in PlugInFile.java
Lines 3, 4, and 6 in the PlugInView.java and PlugInAlgorithm.java files
import the model structures, view functions, and the basic Java package
that has GUI functions (Figure 327).
import gov.nih.mipav.model.structures.*;
import gov.nih.mipav.view.*;
import java.awt.*
Figure 327. Importing model structures, view functions, and [java.awt]
If you reference a class, you must include it in the plug-in package so that it
can be called from the main file. After you write and compile, you must now
install files in the user or home directory:
Windows
c:\Documents and Settings\<user ID>\mipav\plugins
UNIX
/user/<user ID>/mipav/plugins
An example of this appears in the first line of Figure 328.
package plugins;
Figure 328. Example of placing referenced files in the \$MIPAV\plugins
directory
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LINES OF CODE THAT ARE DEPENDENT ON
PLUG-IN TYPE

Two lines of code depend on the type of plug-in program being developed:

e Declaration
e Parameters for the run method

Declaration

The declaration used in a plug-in depends on the type of plug-in being
developed. For instance, in line 9 in PlugInAlgorithm.java (Figure 325), the
combination of words “public interface PlugInAlgorithm” indicates that
the plug-in in an Algorithm. For File or View types of plug-ins, simply
replace PlugInAlgorithm with PlugInFile (line 7 in PlugInFile.java, see
Figure 323) or PlugInView (line 8 in PlugInView.java, see Figure 324),
respectively.

Table 4. Declarations dependent on type of plug-in

Type of plug-in Declaration

File public interface PlugInFile extends PlugIn (
View public interface PlugInView extends PluglIn (
Algorithm public interface PlugInAlgorithm extends PlugIn (

Parameters for the run method

The parameters for the run method also depend on the plug-in type.
Compare the run methods used in PlugInFile.java (Figure 323),
PlugInView.java (Figure 324), and PlugInAlgorithm.java (Figure 325).

Table 5. Parameters for run methods dependent on type of plug-in

Type of plug-in

Parameters for the run method

File public void run (ViewUserInterface UI);

View public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image);

Algorithm public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image);
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1 package gov.nih.mipav.plugins;

2

3 import gov.nih.mipav.model structures.*;

4 import gov.nih.mipav.view.*;

5

6 import java.awt *;

7

8 public interface PlugInAlgorithm extends PlugIn {

9

10

11 ru

12 @param UI ITPAV mair r interface.

13 iparam yrentFrame Frame that displays the MIPAV image
14 Can be used parent frame e 1
15 dparam image lodel f Is MI imag

16 isee ModelImage

17 dsee iewJFrameIm e

18

19 public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image;)
20

21 }

Figure 329. PlugInAlgorithm.java. For readability purposes, keywords in all code reproduced in
this chapter appear in bold, and comments appear in green type

Building and compiling plug-in programs

To build a new plug-in program for MIPAV, you must first install a build
environment, alter the path environment variable, and compile the plug-in
files.

INSTALLING A BUILD ENVIRONMENT

1 Download and install Java SE Development Kit (JDK), version 1.6 (JDK
6u2) <http://java.sun.com/javase/downloads/index.jsp>.

2 Download and install Apache Ant 1.7.0 <http://ant.apache.org/>.
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Figure 330. Download pages for Java SE Development Kit (JDK) and
Apache Ant 1.7.0

CONFIGURING THE ENVIRONMENT

To configure your environment, you need to add two new variables—
JAVA_HOME and ANT_HOME—and update the path variable in your
system.

On Windows workstations

1

2

6

Click Start > Control Panel. The Control Panel window opens.
Double-click the System icon. The System Properties dialog box opens.

Click Advanced. The Advanced page of the System Properties dialog box
appears.

Click Environment Variables. The Environment Variables dialog box
opens.

Decide whether to add and edit variables in the User variables box or the
System variables box based on which users should have access to the
Java SDK and Ant.

Add the JAVA_ HOME variable to your environment:

a Click New. The New User Variable dialog box or the New System
Variable dialog box opens.

b Type Java_noME in Variable name.
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¢ Type the path for the Java SDK on your computer (e.g., C: \Program
Files\Java\jdkl.6.0 02)in Variable value.

d Click OK. The JAVA_ HOME variable appears in either the User
variables box or System variables box as appropriate.

7 Add the aNT HOME variable to your environment by doing the following:

a Click New under either the User variables box or the System
variables box. The New User Variable dialog box or the New System
Variables dialog box opens as appropriate.

b Type ANT_HOME in Variable name.

¢ Type the path for the Ant on your computer (e.g., C: \Program
Files\Ant\apache-ant-1.7.0) in Variable value.

d Click OK. The ANT_HOME variable appears in either the User
variables box or System variables box as appropriate.

8 Update either the PATH variable in the User variables box or the Path
variable in the System variables box by doing the following:

a Select the PATH variable in the User variables box, or select the Path
variable in the System variables box.

b Click Edit under the User variables box, or click Edit under the
System variables box. Either the Edit User Variable dialog box or the
Edit System Variable dialog box opens.

¢ Type;%JAVA HOMES$\bin;%ANT HOME%\bin tothe end of the PATH
variable or to the end of the Path variable.

d Click OK. The edited variable appears either in the User variables
box or the System variables box. See also Figure 331.

9 Open a new terminal for the change to take effect by doing the
following;:

a Click Start > Run. The Run dialog box opens.
b Type emd in Open, and click OK. A terminal window opens.

10 Retrieve the sample Ant build file (build.xml) from the MIPAV web site
and place it in the same directory as the plug-in. java files you want to
compile.
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11 Alter the dir.mipav and dir.jdk properties within the build.xml to
point to the directory where MIPAV and the SDK are installed,
respectively.

System Properties

“r'ous must be logged on as an Admmistiator bo make most of these changes

System Restore I
Geneisl | ComputesName |

Pestormance

Automatic Updates
Hardware

Wizual effects, processor scheduling, memory uzage, and virtual memaony

User Profiles
Deskiop settings related to your logon

Startup and Flecoveny
Sypstem starbup, syztem faiure, and debuggng i

Settings

[~ Lser variables For vor

Environment Variables

- |

Vanable

AT, HOME
APR_ICONY_PATH
JAVA_HOME

Path
TEMP

[~ Syshem wa

Wanable
hPA_ICC

CLASSRA T —

ComSpec
FP_NC_HOST ...
MUMEER_OF P...

Edit User Yariable

Maristle pame:
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| Valus

| Program FilesiSubversioniicony
C:\Program Files) 1avaljdk] .6.0_0Z

| AnT_HOME

Edit User Variable |7 <]

Wariahle name:

| 3ava_HOME |

Cv
N

2 Weriable value:

Figure 331. Configuring system variables for MS Windows

Note: Add and edit the variables in the User variables box if you want to limit the
build environment to just yourself and no other users. Add and edit the variables
in the Systems variables box to make the environment accessible to anyone who
uses the workstation.

Recommendation: Although it is possible to update the path variable in
either the User variables box or System variables box, you should add the
statement to the same box in which you added the JAVA_HOME and
ANT_HOME variables.

See also:

“Installing Ant” on <http://ant.apache.org/manual/index.html>.

“JavaTM SE 6 Release Notes—Microsoft Windows Installation (32-

bit)” on <http://java.sun.com/javase/6/webnotes/install/jdk/
install-windows.html>.
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On Linux or UNIX workstations
Bash users should do the following:

1 Edit the file $HOME/.bash profile and add lines similar to following:

ANT HOME=/path/to/apache-ant-1.6.3
JAVA HOME=/path/to/j2sdkl.4.2 08
PATH=$PATH:$JAVA_HOME/bin:$ANT_HOME/bin

export ANT HOME
export JAVA HOME
export PATH

where ANT _HOME and JAVA_HOME are the paths where each
application was installed.

2 Retrieve the sample Ant build file from the MIPAV web site, and place it
in the same directory where the plug-in . java files you want to compile
are located.

3 Alter the dir.mipav and dir.jdk properties within build.xml to point to
the directory where MIPAV and the SDK are installed, respectively.

BUILD.XML

Figure 332 below displays the content of the build.xml file. build.xml is
also available on the MIPAV web site <http://mipav.cit.nih.gov/

documentation/presentations/plugins/build.xml>.

MIPAV User’s Guide, Volume 1, Basics 554
12/2/08


http://mipav.cit.nih.gov/documentation/presentations/plugins/build.xml
http://mipav.cit.nih.gov/documentation/presentations/plugins/build.xml
http://mipav.cit.nih.gov/documentation/presentations/plugins/build.xml

MIPAV User’s Guide, Volume 1, Basics

MIPAYV
build.xml

1 <!-- build file for MIPAV plugin class -->

2 -

3 <project basedir="." default="compile" name="mipav plugin">

4 <property name="dir.mipav" value="c:\\Program Files\\mipav\\"/>

5 <property name="dir.jdk" value="c:\\Program Files\\Java\\jdkl.6.0 02"/>

6 -

7 <target name="init">

8 <tstamp/>

9 -

10 <path id="build.classpath">

11 <pathelement path="${dir.mipav}"/>

12 <pathelement location="${dir.mipav}/InsightToolkit/lib/InsightToolkit/InsightToolkit.jar"/>

13 =

14 <fileset dir="${dir.mipav}">

15 <filename name="*.jar"/>

16 </fileset>

17 </path>

18 <property name="build.cp" refid="build.classpath"/>

19 </target>

20 =

21 <target name="compile" depends="init">

22 <echo>classpath: ${build.cp}</echo>

23 =

24 <javac debug="true" deprecation="true" description="Builds MIPAV" verbose="no"
listfiles="yes" nowarn="no" fork="true" memoryInitialSize="220M" memoryMaximumSize="1000M"
id="mipav build" source="1.4" target="1.4" destdir="." srcdir="." compiler="modern">

25 <classpath refid="build.classpath"/>

26 </javac>

27 </target>

28 =

29 <target name="clean" depends="init">

30 =

31 <delete>

32 =

33 <fileset dir=".">

34 <include name="**/*_class"/>

35 </fileset>

36 </delete>

37 </target>

38 </project>

Figure 332. The contents of the build.xml file
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COMPILING THE PLUG-IN FILES
Note: You should keep back-up copies of the source and compiled files in case
you need to update or change the plug-in.

1 Type ant compile on your workstation (e.g., cmd ant compile on
Windows or xterm ant compile on UNIX platforms). The BUILD
SUCCESSFUL message should appear at the end of the Ant output.

2 Copy the .c1lass files that Ant produced into MIPAV’s plug-in directory.

¢ On Windows platforms:
C:\Documents and Settings\username\mipav\plugins
¢ On UNIX platforms:
/home/username/mipav/plugins
where username is the name of your account on the system.

3 Install the plug-in file. Select PlugIns > Install Plugin in the main
MIPAV window. In the Install Plugln dialog box, use the Browse buton
to navigate to the \plugins directory . Select the plug-in and Press OK.

S}]Medical Image Processing, Analysis & Yisualization {MIPAY)
File |Plugins | Scripts  Help
General »
5 [F;i]lnstall Plugin E
Mipay Mstallplugin \ Memory usege: 19M /793M | 73
Install Plugin Parameters
‘ 0K ‘ ‘ Cancel ‘
Figure 333. Installing a MIPAV plug-in.
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Creating a self-contained plug-in frame

You can create a self-contained plug-in that does not rely on the default
MIPAYV user interface. When running, this type of plug-in hides MIPAV and
displays its own image(s) with the action and algorithm handling specific to
its frame.

TO CREATE A SELF-CONTAINED PLUG-IN:

1 Extend viewJFrameImage, as this will allow the plug-in to use a wide-
range of ViewJFrameImage and ViewJFrameBase specific functions for
storing and displaying Mode1Images. These functions include, for
example, the image and on-screen buffers, menu and toolbar builders,
etc.

2 Override the ViewOpenFrameInterface openFrame (ModelImage)
function. This handles the creation of a new P1ugIn frame based on
whether a result image is created within the dialog of an algorithm. For
example, when the user runs an algorithm and selects the destination
New Image rather than Replace Image, a new frame will be created with
the result of the algorithm. To set all algorithms to work in place and
disallow creating of new frames, call viewUserInterface
setForceInPlace (true) function, which tells the dialogs that all
algorithms must work in place.

3 Create an init () function, where the P1ugIn frame is layout and
components will be initialized.

4 Inthe init () function, several methods should be called:
e Call initrur () for the ModelImage look-up table,
e Call initResolutions () for the ModelImage resolutions,
e Call initZoom () for the frame's zoom factor,
® initComponentImage () createsa displayable ComponentImage,

e initExtentsVariables () initializes z-slice and time-slice
positions.

5 To add toolbars and menus to your plug-in, within init (), createa
ViewControlsImage object, and then
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e CallbuildToolBar () to create pre-defined toolbars for image, VOI,
paint, and scripting controls;

e Orcall buildSimpleToolBar and pass
Vector<CustomUIBuilder.UIParams> using
addCustomToolBar () for each of the Vectors.

Pre-defined button and menu parameters are located in CustomUIBuilder.
Pre-defined as well as the user-defined UIParams can be added and used in
both toolbars and menus.

6 Create viewMenuBar. This allows you to add either pre-defined or
UIParam menus. The Vector from above (used on the custom toolbar)
can be passed into the viewMenuBar makeCustomMenu () function.
ViewMenuBar also has pre-defined menus for a file, help, image, look-up
tables, etc.

77 Finally, the init () function should handle the container for the
ViewJComponentEditImage created from initComponentImage ().
The component image should be added to a Jscrollpane to
accommodate the variable size of the display.

8 Override the actionPerformed () method to catch (handle)
ActionEvents. If a custom toolbar and (or) menu bar was created using
a Vector of UIParams, the UIParam contains the action event for each
button and (or) menu item.

9 Override the componentResized () method to properly handle (or
ignore) the resizing of the plug-in frame. Using the viewJFrameImage
componentResized function would likely create unwanted behavior as
the layout of the plug-in is different from MIPAV’s standard

ViewJFrameImage.

10 Create a basic P1ugInGeneric class that will be called as a command-
line argument. This class should have the ability to choose/open a
ModelImage using the rileTtO. readImage () method. The self-
contained plug-in frame should be instantiated within this class by
passing in the Mode1Image.

11 When running MIPAV, pass in the arguments

-hide -p [YourGenericPlugin].The -hide flag tells MIPAV not to bring
up the User Interface and MessageFrame, while the -p flag tells which plug-
in to run. See Figure 334.
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Figure 334. The arguments for running the self-contained plug-in
frame.
Optional:
The viewJFrameMessage Data and Debug tabs (as well as others) can be
added to the plug-in frame by retrieving the JTabbedPane through
ViewUserInterface.getReference () .getMessageFrame () .getTabbedP
ane (). This enables the Data and Debug message output to be displayed
outside of the separate message frame that accompanies MIPAV.
See also: Figure 335 and Figure 336.
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PlugInDialogImageVOIDisplay.java
1 import java.awt.*;
2 import java.awt.event.*;
3 import java.util.Vector;
4
5 import javax.swing.*;
6 import gov.nih.mipav.model.file.FileInfoBase;
7 import gov.nih.mipav.model.structures.ModelImage;
8 import gov.nih.mipav.model.structures.ModelLUT;

I e S R e S (o)
o WN O

=
~

18
19
20
21

22
23
24
25

26
27
28
29
30
31
32
33
34
33
36
37
38
39
40
41

Figure

import gov.nih.mipav.model.structures.ModelRGB;
import gov.nih.mipav.model.structures.VOI;
import gov.nih.mipav.view.*;

import gov.nih.mipav.view.dialogs.*;

/**

* Plugin example class for creating a simple, self-contained frame that extends ViewJFrame
Image

* Contains a subset of the VOI functions, as well as the message frame contained within the
frame itself

* @author linkb

*

*/
public class PlugInDialogImageVOIDisplay extends ViewJFrameImage implements MouseListener,
AdjustmentListener {

/**
* Default constructor
*/
PlugInDialogImageVOIDisplay (ModelImage image) {
(image, 7 7 7 ) 8
init () ;
}
/**
* ViewOpenFramelInterface function for opening a model image (result) into a new frame
*/

PlugInDialogImageVOIDisplay openFrame (ModelImage image) {
PlugInDialogImageVOIDisplay (image) ;
}

335. A part of the code for PlugInDialogImageVOIDisplay.java. The full code can be found

in "Examples of MIPAV plug-ins” , Figure 345.
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Figure 336. The Simple Image Frame plug-in opens the MIPAV independent image frame for a
selected image. (a) The image frame contains the following elements of the interface - the VOI
toolbar, image slice slider and menu bar. The Gradient Magnitude algorithm was called from the
menu and applied to the image. (b) The result image opened in a new image frame.

MIPAV User’s Guide, Volume 1, Basics

561
12/2/08



MIPAV User’s Guide, Volume 1, Basics

aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa

Installing plug-in programs

Installing simple plug-in programs merely copies files into the user’s home
directory.

Windows

c:\Documents and Settings\<user ID>\mipav\plugins

UNIX

/user/<user ID>/mipav/plugins

You can choose one of two methods for copying the files:

e Use MIPAV’s plug-in installation tool, e.g. in the MIPAV window,
select PlugIns > Install PlugIns.

e Use the operating system’s tool for copying the files. This method
requires the user to restart MIPAV so that the new plug-in appears in
the PlugIns menu. When MIPAV starts, it parses the user’s home
directory and builds the PlugIns menu.

Warning: The MIPAV installation tool does not work for more complex plug-ins
that consist of more complicated package class hierarchy, such as the Medic
Talairach plug-in program. To learn more about Medic Talairach plug-in program,
refer to MIPAV Technical Guide 1.

Examples of MIPAV plug-ins

To build plug-in programs, three files are typically required:
¢ PluginFoo.java—Provides an interface to MIPAV and the plugin.

¢ PluginDialogFoo.java—Invokes the dialog to get user-supplied
parameters; it can be hidden when no parameters are required.

¢ PluginAlgorithmFoo.java—Provides the actual algorithm to be
implemented. It can be a mixture of calls to MIPAV’s API, C programs,
Perl, ITK, etc.

Where Foo is the name that you supply for the program. The following
sample plug-in program(s) are included in MIPAV documentation:

¢ PlugInSample—a sample plug-in, see “Sample plug-in program”
below.
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e PlugInCT_MD—a typical plug-in. (Refer to the MIPAV Users Guide,

PDF version.)
¢ PluglnAlgorithm.Median—a very complicated plug-in. Refer to MIPAV
Volume 1 Users Guide, Appendix D.
¢ PluginDialoglmageVOIDisplay.java — a self contained plug-in.
SAMPLE PLUG-IN PROGRAM
The source code for the plug-in program, PlugInSample.java is an example
of a simple algorithm type of plug-in. See Figure 337.
PlugInSample.java

1 import gov.nih.mipav.plugins.*;
2
3 import gov.nih.mipav.view.*;
4 import gov.nih.mipav.model.structures.*;
5 import java.awt.*;
6
7
8
9
10
11
12
13 public class PlugInSample implements PlugInAlgorithm {
14
15
16
17
18
19
20
21
22 public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image) {
23 if (parentFrame instanceof ViewJFrameImage) {
24 new PlugInDialogSample (parentFrame, image) ;
25 } else {
26 MipavUtil.displayError ("PlugInSample only runs on an image frame.");
27 }
28 }
29 }

Figure 337. PlugInSample.java

PlugInSample.java opens an image in a new image frame using its own dia-
log box. It requires three files:
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PlugInSample.java—Provides an interface to MIPAV and the
plug-in program. See Figure 337 on page 563.
PlugInDialogSample.java—Invokes the dialog to get user-
supplied parameters. Refer to Figure 338 on page 564.
PlugInAlgorithmSample.java—Implements the algorithm. See
Figure 339.

PlugInDialogSample.java

nih.mipav.view.*;
nih.mipav.view.dialogs.*;
nih.mipav.model.structures.*;
nih.mipav.model.algorithms.*;

java.awt.event.*;
java.awt.*;
Java.util.*;

javax.swing.*;

class PlugInDialogSample extends JDialogBase implements AlgorithmInterface {

private ModelImage image;
private ViewUserInterface userInterface;

private PlugInAlgorithmSample sampleAlgo = null;

public PlugInDialogSample (Frame theParentFrame, ModelImage im) {
super (theParentFrame, false);

if ((im.getType() == ModelImage.BOOLEAN) || im.isColorImage()) {
MipavUtil.displayError ("Source Image must NOT be Boolean or Color");
dispose();
return;

}

image = im;

userInterface = ViewUserInterface.getReference();

init () ;

PlugInDialogSample.java
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36
37
38
39
40
41
42
43
44
45 public void actionPerformed (ActionEvent event)

46 String command = event.getActionCommand() ;

47

48 if (command.equals ("OK")) {

49 callAlgorithm() ;

50 } else if (command.equals("Cancel")) {
51 dispose();

52 }

53 }

54

55

56

57

58 private void init () {

59

60

6l JPanel OKCancelPanel = new JPanel();
62

63 JLabel questionLabel = new JLabel ("Display Images?");

64
65
66 buildOKButton () ;

67 OKCancelPanel.add (OKButton, BorderLayout.WEST) ;

68
69
70 buildCancelButton () ;

71 OKCancelPanel.add(cancelButton, BorderLayout.EAST) ;

{

72 getContentPane () .add (questionLabel, BorderLayout.NORTH) ;
73 getContentPane () .add (OKCancelPanel, BorderLayout.SOUTH) ;

74

75 pack();

76 setVisible (true) ;

77 setResizable (false) ;
78 System.gc () ;

79 }

Figure 338. PlugInDialogSample.java (continued)
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81

82

83

84 public void algorithmPerformed(AlgorithmBase algorithm) {
85 if (algorithm instanceof PlugInAlgorithmCT MD) {
86 if ( sampleAlgo.isCompleted() ) {

87 dispose();

88 }

89 }

90 }

91

92

93

94

95 protected void callAlgorithm() {

96 sampleAlgo = new PlugInAlgorithmSample (null, image) ;
97 sampleAlgo.addListener (this) ;

98 setVisible (false) ;

99

100 if (isRunInSeparateThread()) {

101

102

103 if (sampleAlgo.startMethod(Thread.MIN PRIORITY) == false) {

104 MipavUtil.displayError ("A thread is already running on this object");
105 }

106 } else {

107 sampleAlgo.run() ;

108 }

109 }

110

111 }

Figure 338. PlugInDialogSample.java (continued)
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PlugInAlgorithmSample.java
1 import gov.nih.mipav.model.algorithms.AlgorithmBase;
2 import gov.nih.mipav.model.structures.*;
3
4 import gov.nih.mipav.view.*;
5
6
7 public class PlugInAlgorithmSample extends AlgorithmBase {
8
9 private ViewJFramelImage frame;
10
11
12
13
14
15
16
17
18 public PlugInAlgorithmSample (ModelImage destImg, ModellImage srclImg) {
19 super (destImg, srcImg);
20 }
21
22
23
24
25
26
public void finalize() {
destImage = null;
srcImage = null;

super.finalize();

public void runAlgorithm() {
frame = new ViewJFrameImage ( (ModelImage)srcImage.clone());
setCompleted (true) ;

BB W WwWwwWwwwwwwwdhdDNdDN
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i
N

}

Figure 339. PlugInAlgorithmSample.java
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PLUGINCT_MD, A TYPICAL PLUGIN
PROGRAM

PlugInCT_MD is a typical example of a plug-in program. It consists of three
files:

¢ PlugInCT_MD.java—Provides an interface to MIPAV and the plug-
in program.

¢ PlugInDialogCT_MD.java—Invokes the dialog to get user-supplied
parameters.

¢ PlugInAlgorithmCT_MD.java—Implements the algorithm.

PlugInCT_MD.java

The file in Figure 340 provides an interface between MIPAV and
PlugInCT_MD.

PlugInDialogCT_MD.java

The PlugInDialogCT_MD.java file invokes a dialog box to obtain user-
supplied data. Refer to Figure 341 on page 570.

PlugInAlgorithmCT_MD.java
Figure 343 on page 580 shows the content of PlugInAlgorithmCT_MD.java.

PlugInDialogImageVOIDisplay.java

Figure 345 on page 586 shows a sample code for a self-contained frame
plug-in.

Note: For readability purposes, keywords in all code reproduced in this chapter
appear in bold, and comments appear in green type
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PlugInCT_MD.java

1 import plugins.PlugInDialogCT MT; //ass iated c

2 import gov.nih.mipav.plugins.*; to 1lc / Plug e
3 //PlugInFile interf

4 import gov.nih.mipav.view.*;

5 import gov.nih.mipav.model.structures.*;

6

7 import java.awt.*;

8

9

10 mple an

11

12

13 e PlugInAlgorithm

14

15

16 //This is an Algorithm type of PlugIn, and therefore must lement PlugInAlgorithm
17 //Implementing the P requires this class ment the run method
18 //with the correct paramete

19 public class PlugInCT MD implements PlugInAlgorithm {

20

21 // * *

22

23

24 >

25 # a image Current JelImage--this is an image alre 1 into
26 i MIPAV. Can be null.

27 /

28 public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image) {
29

30 if (parentFrame instanceof ViewJFramelImage)

31 new PlugInDialogCT MD (parentFrame, image);

32

33 else

34 MipavUtil.displayError (“PlugIn CT MD only runs on an image frame.”);
35 }

36 }

37 }

Figure 340. PlugInCT_MD.java
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PlugInDialogCT_MD.java

1 import gov.nih.mipav.view.*;

2 import gov.nih.mipav.view.dialogs.*;

3 import gov.nih.mipav.model.structures.*;
4 import gov.nih.mipav.model.algorithms.*;
5

6 import java.awt.event.*;

7 import java.awt.*;

8 import java.util.*;

9

10 import javax.swing.*;

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30 public class PlugInDialogCT MD extends JDialogBase implements AlgorithmInterface ({
31

32 private PlugInAlgorithmCT MD ctSegAlgo = null;
33 private ModelImage image;

34 private ModelImage resultImage = null;
35 private ViewUserInterface userInterface;
36

37 private String titles[];
38

39 private float correctionval;
40 private JTextField fatLValTF;
41 private JTextField fatHValTF;
42 private JTextField 1dmLValTF;
43 private JTextField 1dmHValTF;
44 private JTextField hdmLValTF;
45 private JTextField hdmHValTF;
46

47 private int fatlLval;

48 private int fatHval;

49 private int ldmLval;

50 private int ldmHVal;

51 private int hdmLval;

52 private int hdmHVal;

53

Figure 341. PlugInDialogCT_MD.java
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54
53
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106
107

Figure 341.

public PlugInDialogCT MD (Frame theParentFrame, ModelImage im) {

super (theParentFrame, true);

if (im.getType () == ModelImage.BOOLEAN im.isColorImage()) {
MipavUtil.displayError ("Source Image must NOT be Boolean or Color");
dispose () ;
return;

}

image = im;

userInterface = ((ViewJFrameBase) (parentFrame)) .getUserInterface();

init ()

public PlugInDialogCT MD (ViewUserInterface UI, ModelImage im) {

super () ;
userInterface = UI;

if (im.getType () == ModelImage.BOOLEAN
MipavUtil.displayError ("Source Image must NOT be Boolean or Color");

dispose();
return;

image = im;

up the GUI (panels,

private void init () {

setForeground (Color.black) ;

setTitle ("CT_ segmentation");

JPanel inputPanel = new JPanel (new GridLayout (3,
inputPanel.setForeground (Color.black) ;

im.isColorImage ()) {

3));

inputPanel.setBorder (buildTitledBorder ("Input parameters"));

JLabel labelFat = new JLabel ("Fat thresholds:
labelFat.setForeground (Color.black) ;

labelFat.setFont (serifl2);

inputPanel.add (labelFat) ;

PlugInDialogCT_MD.java (continued)
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108 fatLValTF = new JTextField() ;

109 fatLValTF.setText ("-190") ;

110 fatLValTF.setFont (serifl2) ;

111 inputPanel.add (fatLvalTF) ;

112

113 fatHValTF = new JTextField();

114 fatHValTF.setText ("-30") ;

115 fatHValTF.setFont (serifl2);

116 inputPanel.add (fatHValTF) ;

117

118 JLabel labellDM = new JLabel ("Low density muscle thresholds: ");
119 labellDM.setForeground (Color.black) ;

120 labellLDM.setFont (serifl2) ;

121 inputPanel.add (labellDM) ;

122

123 1dmLValTF = new JTextField() ;

124 1dmLValTF.setText ("0") ;

125 1dmLValTF.setFont (serifl2) ;

126 inputPanel.add (1dmLValTF) ;

127

128 1dmHValTF = new JTextField() ;

129 1dmHValTF.setText ("30") ;

130 1dmHValTF.setFont (serifl2) ;

131 inputPanel.add (1dmHValTF) ;

132

133 JLabel labelHDM = new JLabel ("High density muscle thresholds: ");
134 labelHDM. setForeground (Color.black) ;

135 labelHDM. setFont (serifl2) ;

136 inputPanel.add (labelHDM) ;

137

138 hdmLValTF = new JTextField();

139 hdmLValTF.setText ("31") ;

140 hdmLValTF.setFont (serifl2) ;

141 inputPanel.add (hdmLValTF) ;

142

143 hdmHValTF = new JTextField() ;

144 hdmHValTF.setText ("100") ;

145 hdmHValTF.setFont (serifl2) ;

146 inputPanel.add (hdmHValTF) ;

147

148 getContentPane () .add (inputPanel, BorderLayout.CENTER) ;
149

150 Build the Panel that holds the OK and CANCE

151 JPanel OKCancelPanel = new JPanel () ;

152

153 size and place the OK button

154 buildOKButton () ;

155 OKCancelPanel.add (OKButton, BorderLayout.WEST) ;
156 size and place the CANCEL button

157 buildCancelButton () ;

158 OKCancelPanel.add (cancelButton, BorderLayout.EAST) ;
159 getContentPane () .add (OKCancelPanel, BorderLayout.SOUTH) ;

Figure 341. PlugInDialogCT_MD.java (continued)
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160
161l
162
163
164
165 }
166

167

168 ¢
169 *  Qre
170 g
171
172
173
174
175
176 * Acce

pack() ;
setVisible (true) ;

System.gc () ;

// end init ()

ModelImage

177 . @param num alue

178
179
180
181
182
183
184
185
186

187 - @param event Event

188
189
190
191
192
193
194
195 }
196 }

197 else if
198

199 }
200 else if
201 dispose();
202 }

203 }
204

205

206

207

208

209

210

211

212

213

214

215

String command =

if
if

setResizable (false) ;

image.

image.

(command.equals ("OK") )
(setVariables () )
callAlgorithm() ;

getResultImage () {return

{
{

(command.equals ("Script"))
callAlgorithm() ;

(command.equals ("Cancel"))

Figure 341. PlugInDialogCT_MD.java (continued)

resultImage; }

public void actionPerformed (ActionEvent event)

{

{

{

event.getActionCommand () ;

public void algorithmPerformed (AlgorithmBase algorithm)

public void setCorrectionValue (float num) {correctionVal

{

= num; }

//************************************************************************
//************************** Event Processing R R R R R R R R R R R R

//************************************************************************

//************************************************************************
//************************** AlgOKithm Events KAKKA AKX AKX XXX XXX XXX XA XXX XA XXX XX K

//************************************************************************
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216 ViewJFrameImage imageFrame = null;
217 if ( algorithm instanceof PlugInAlgorithmCT MD) {
218 image.clearMask() ;
219 if (ctSegAlgo.isCompleted() == true && resultImage != null) {
220 The algorithm has completed and produced a new image to be displayec
221
222 updateFileInfo (image, resultImage);
223 resultImage.clearMask() ;
224 try {
225 resultImage.setImageName ("Median: "+image.getImageName ()) ;
226
227 int dimExtentsLUT[] = new int([2];
228 dimExtentsLUT[0] = 4;
229 dimExtentsLUT[1] = 256;
230 ModelLUT LUTa = new ModelLUT (ModelLUT.COOLHOT, 256, dimExtentsLUT) ;
231 imageFrame = new ViewJFrameImage (resultImage, LUTa, new Dimension(610,200),
232 userInterface) ;
233 }
234 catch (OutOfMemoryError error) {
235 System.gc () ;
236 MipavUtil.displayError ("Out of memory: unable to open new frame");
237 }
238 }
239 else if (resultImage == null) {
240 These nes: lines the titles in all frames where the urce imag
241 is i e ) imac to indicate that the image i
242 unl ed! The image ame ~nabled and then registered
243 userinterface.
244 Vector imageFrames = image.getImageFrameVector () ;
245 for (int i = 0; 1 < imageFrames.size(); i++) {
246 ((Frame) (imageFrames.elementAt (i))) .setTitle(titles[i]);
247 ((Frame) (imageFrames.elementAt (i))) .setEnabled(true) ;
248 if ( ((Frame) (imageFrames.elementAt(i))) != parentFrame) {
249 userInterface.registerFrame ( (Frame) (imageFrames.elementAt (i)));
250 }
251 }
252 if (parentFrame != null) userInterface.registerFrame (parentFrame);
253 image.notifyImageDisplayListeners (null, true);
254 }
255 else if (resultlImage != null) {
256 algorithm failed but result image 1 has garbage
257 resultImage.disposelocal () ; 1] up memc
258 resultImage = null;
259 System.gc () ;
260 }
261 }
262 if (ctSegAlgo.isCompleted() == true) {
263 if (userInterface.isScriptRecording()) {
264 userInterface.getScriptDialog () .append ("Flow " +
265 userInterface.getScriptDialog () .getVar (image.getImageName()) + " "
266 + correctionVal + "\n");
267 }
268 }
269 dispose () ;
270
Figure 341. PlugInDialogCT_MD.java (continued)
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271 } end AlgorithmPerformed ()

272

273

274

275 * Use the GUI results to set up the variables needed to run the algorithm.
276 * @return code>true de i parameters se successfully, >ode>fa
277 d </code> otherwise.

278 .

279 private boolean setVariables () {

280 String tmpStr;

281

282

283 verify iteration is within bounds

284 tmpStr = fatLvValTF.getText ()

285 if ( testParameter (tmpStr, -4000, 4000) ){

286 fatLval = Integer.valueOf (tmpStr).intValue();
287 }

288 else(

289 fatLVvalTF.requestFocus () ;

290 fatLvalTF.selectAll () ;

291 return false;

292 }

293

294 tmpStr = fatHValTF.getText ()

295 if ( testParameter (tmpStr, -4000, 4000) ) {

296 fatHVal = Integer.valueOf (tmpStr) .intValue() ;
297 }

298 else{

299 fatHValTF.requestFocus () ;

300 fatHValTF.selectAll () ;

301 return false;

302 }

303

304 tmpStr = ldmLValTF.getText () ;

305 if ( testParameter (tmpStr, -4000, 4000) ) {

306 ldmLVal = Integer.valueOf (tmpStr).intValue() ;
307 }

308 else{

309 1dmLValTF.requestFocus () ;

310 1dmLValTF.selectAll () ;

311 return false;

312 }

313

314 tmpStr = 1dmHValTF.getText () ;

315 if ( testParameter (tmpStr, -4000, 4000) ){

316 ldmHVal = Integer.valueOf (tmpStr).intValue();
317 }

318 else(

319 1dmHValTF.requestFocus () ;

320 1dmHValTF.selectAll () ;

321 return false;

322 }

323

324

Figure 341. PlugInDialogCT_MD.java (continued)
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325 tmpStr = hdmLValTF.getText () ;

326 if ( testParameter (tmpStr, -4000, 4000) ) {

327 hdmLVal = Integer.valueOf (tmpStr) .intValue();

328 }

329 else(

330 hdmLValTF.requestFocus () ;

331 hdmLValTF.selectAll () ;

332 return false;

333 }

334

335 tmpStr = hdmHValTF.getText () ;

336 if ( testParameter (tmpStr, -4000, 4000) ){

337 hdmHVal = Integer.valueOf (tmpStr) .intValue();

338 }

339 else(

340 hdmHValTF.requestFocus () ;

341 hdmHValTF.selectAll () ;

342 return false;

343 }

344

345 return true;

346 } end setVariables ()

347

348

349 ’ he

350 alg his nd

351 . is a

352

353 private void callAlgorithm() {

354 String name = makeImageName (image.getImageName (), " CTseg");
355

356 stuff to do when working on 2-D images.

357 if (image.getNDims() == 2 ) { source image
358 int destExtents[] = new int[2];

359 destExtents[0] = image.getExtents () [0]; X d

360 destExtents[1l] = image.getExtents () [1]; Y dir

361

362 try{

363 Make result image of Ubyte type

364 resultImage = new ModelImage (ModelStorageBase.UBYTE, destExtents, name,
365 userInterface);

366

367 Make algorithm

368 boolean entireFlag = true;

369

370 rithmFlo apFix (resultImage, image, iters,
371 stdDev, ionFlag) ;

372 = new PlugInAlgorithmCT MD (resultImage, image);
373

374 System.out.println("Dialog fatL = " + fatLval + " fatH = " + fatHval);
375 ctSegAlgo.fatlL = fatLVal;

376 ctSegAlgo.fatH = fatHvVal;

377 ctSegAlgo.ldmL = ldmLVal;

378 ctSegAlgo.ldmH = 1ldmHVal;

Figure 341. PlugInDialogCT_MD.java (continued)
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379 ctSegAlgo.hdmL = hdmLVal;

380 ctSegAlgo.hdmH = hdmHVal;

381

382

383

384 This is e

385 algorithm to no

386 // algorithm

387 This is made possible by implementing Algorithme \terface
388 ctSegAlgo.addListener (this) ;

389 setVisible (false) ; Hide dialog

390

391 if (runInSeparateThread) {

392 Star hread as priori becau ish t ill ha
393 user interface work fast.

394 if (ctSegAlgo.startMethod(Thread.MIN PRIORITY) == false) {

395 MipavUtil.displayError ("A thread is already running on this object");
396 }

397 }

398 else {

399 ctSegAlgo.run();

400 }

401 }

402 catch (OutOfMemoryError x) {

403 MipavUtil.displayError ("Dialog median: unable to allocate enough memory") ;
404 if (resultImage != null) {

405 resultImage.disposeLocal(); Clean up memory of result image
406 resultImage = null;

407 }

408 return;

409 }

410 }

411 else if (image.getNDims() == 3 ) {

412 int destExtents[] = new int[3];

413 destExtents[0] = image.getExtents() [0];

414 destExtents[l] = image.getExtents () [1];

415 destExtents[2] = image.getExtents() [2];

416

417 try{

418 Make result image of float type

419 resultImage = new ModelImage (ModelStorageBase.UBYTE, destExtents, name,
420 userInterface);

421 boolean entireFlag = true;

422

423 ctSegAlgo = new PlugInAlgorithmCT MD(resultImage, image);

424 ctSegAlgo.fatlL = fatLVal;

425 ctSegAlgo.fatH = fatHvVal;

426 ctSegAlgo.ldmL = ldmLVal;

427 ctSegAlgo.ldmH = ldmHVal;

428 ctSegAlgo.hdmL = hdmLVal;

429 ctSegAlgo.hdmH = hdmHVal;

430

Figure 341. PlugInDialogCT_MD.java (continued)
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431 This is r importan Adding oject as a 1110 Is
432 algorithm to notify this object v 1 it ha Je faile
433 See algorithm performed event. This ma tir
434 AlgorithmedPerformed interface

435 ctSegAlgo.addListener (this) ;

436 setVisible (false) ; // Hide dialog

437

438 if (runInSeparateThread) {

439 Start the thread as a low p ¥ U 1t )
440 user interface work fast.

4471 if (ctSegAlgo.startMethod(Thread.MIN PRIORITY) == false) {

442 MipavUtil.displayError ("A thread is already running on this object");
443 }

444 }

445 else {

446 ctSegAlgo.run() ;

447 }

448 }

449 catch (OutOfMemoryError x) {

450 MipavUtil.displayError ("Dialog median: unable to allocate enough memory");
451 if (resultImage != null) {

452 resultImage.disposeLocal () ; 1 1 up 1 ) r

453 resultImage = null;

454 }

455 return;

456 }

457 }

458 } callAlgorithm ()

459

460 }

Figure 341. PlugInDialogCT_MD.java (continued)

PlugInAlgorithmCT_MD.java

1 import gov.nih.mipav.model.algorithms.*;
2 import gov.nih.mipav.model.structures.*;
3 import gov.nih.mipav.view.*;

4

5 import java.io.*;

6 import java.util.*;

7

8

9

10

11 * shows w to extend the AlgorithmBase
12

13 Supports the segmentatior

14 2 C can

Figure 342. PlugInAlgorithmCT_MD.java
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o5¥ing Analysis, & Visualization

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34 $

35

36

37 public class PlugInAlgorithmCT MD extends AlgorithmBase {
38

39

40 private boolean entireImage = true;
41

42 public int fatL = -190;
43 public int fatH = =30¢
44

45 public int ldmL = 0;
46 public int 1dmH = 30;
47

48 public int hdmL = 31;
49 public int hdmH = 100;
50

51

52

53

54

55

56

57

58 public PlugInAlgorithmCT MD (ModelImage destImg, ModelImage srcImg) {
59 super (destImg, srcImg);

60 }

61

62

63

64

65 public void finalize () {

66 destImage = null;

67 srcImage = null;

68 super.finalize();

69 }

70

Figure 342. PlugInAlgorithmCT_MD.java (continued)
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71

72 £ Starts the algorithm.

73 .

74 public void run() {

75

76 if (srcImage == null) {

77 displayError ("Source Image is null");

78 notifyListeners (this);

79 return;

80 }

81 if (destImage == null) {

82 displayError ("Source Image is null");

83 notifyListeners (this);

84 return;

85 }

86

87

88 start the timer to compute the elapsed time
89 setStartTime () ;

90

91 if (destImage != null) { if there exists 1ati ge
92 if (srcImage.getNDims () == 2){

93 calcStoreInDest2D() ;

94 }

95 else if (srcImage.getNDims () > 2) {

96 calcStoreInDest3D() ;

97 }

98 }

99

100 compute the elapsed

101 computeElapsedTime () ;

102 notifyListeners (this);

103 }

104

105

106 * This func roduce new image has been median filtered and places
107 * filtered r I de 11 ion

108 2

109 private void calcStoreInDest2D () {

110

111

112 int length; total number of data-elements
113 float buffer([]; d -buffer (for pixel data)
114 of e image

Figure 343. PlugInAlgorithmCT_MD.java
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115 try {

116 image length is length in 2 dims

117 length = srcImage.getExtents () [0] * srcImage.getExtents () [1];
118 buffer = new float[lengthl];

119 srcImage.exportData (0, length, buffer); locks and releases
120 }

121 catch (IOException error) ({

122 buffer = null;

123 errorCleanUp ("Algorithm CT MD reports: source image locked", true);
124 return;

125 }

126 catch (OutOfMemoryError e) {

127 buffer = null;

128 errorCleanUp ("Algorithm CT MD reports: out of memory", true);
129 return;

130 }

131

132 int mod = length/100; mod is 1 p of ngth

133 initProgressBar () ;

134

135 // Fat: =190 to -30

136 // Low density muscle: 0 to 30

137 // High density muscle: 31 to 100

138 BitSet mask = null;

139 if (srcImage.getVOIs().size() > 0 ) {

140 mask = srcImage.generateVOIMask () ;

141 entireImage = false;

142 }

143

144 int fat = 0;

145 int ldMuscle = 0;

146 int hdMuscle = 0;

147 for (int i = 0; 1 < length && !threadStopped; i++){

148 if (isProgressBarVisible() && (i) %mod==0)

149 progressBar.setValue (Math.round ( (float) (i) / (length-1) * 100));
150

151 if (entireImage == true || mask.get (i) ) {

152 if ( buffer[i] >= fatl && buffer[i] <= fatH ) {

153 destImage.set (i, 20);

154 fat++;

155 }

156 else if( buffer([i] >= 1ldmL && buffer[i] <= 1ldmH ) {
157 destImage.set (i, 40);

158 ldMuscle+t+;

159 }

160 else if( buffer[i] >= hdmL && buffer[i] <= hdmH ) {
161 destImage.set (i, 60);

162 hdMuscle++;

163 }

164 else {

165 destImage.set (i, 0);

166 buffer[i] = (float)srcImage.getMin();

167

168 }

169 }

170 }

171

172

Figure 343. PlugInAlgorithmCT_MD.java
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173 destImage.rele: () 8
174
175 if (threadStopped) {
176 finalize () ;
177 return;
178 }
179
180 float area = srcImage.getFileInfo() [0].getResolutions () [0] *
181 srcImage.getFileInfo () [0] .getResolutions () [1];
182
183 destImage.getUserInterface () .getMessageFrame () .append ("Number of Fat pixels = " +
184 fat , ViewJFrameMessage.DATA );
185 destImage.getUserInterface () .getMessageFrame () .append (" Area = " + (fat*area) +
186 " mm~2\n", ViewJFrameMessage.DATA );
187
188 destImage.getUserInterface () .getMessageFrame () .append ("Number of LDM pixels = " +
189 ldMuscle , ViewJFrameMessage.DATA );
190 destImage.getUserInterface () .getMessageFrame () .append (" Area = " + (ldMuscle*area) +
191 " mm~2\n", ViewJFrameMessage.DATA );
192
193 destImage.getUserInterface () .getMessageFrame () .append ("Number of HDM pixels = " +
194 hdMuscle , ViewJFrameMessage.DATA );
195 destImage.getUserInterface () .getMessageFrame () .append (" Area = " + (hdMuscle*area) +
196 " mm~2\n", ViewJFrameMessage.DATA );
197
198 destImage.calcMinMax () ;
199 setCompleted (true) ;
200 }
201
202
203 * This func an f
204 * Image can Dbe r
205 2 1sing a kernel-
206
207 private void calcStoreInDest3D() {
208
209 int totLength, imgLength;
210 float buffer[];
211
212 float vol = srcImage.getFileInfo() [0].getResolutions () [0] *
213 srcImage.getFileInfo () [0] .getResolutions () [1] *
214 srcImage.getFileInfo () [0].getResolutions () [2];
215
216 try {
217 image totLength is totLength in 3 dims
218 imgLength = srcImage.getSliceSize();
219 totLength = srcImage.getSliceSize () * srcImage.getExtents() [2];
220 buffer = new float[totLength];
221 srcImage.exportData (0, totLength, buffer); locks and releases lock
222 buildProgressBar (srcImage.getImageName (), "Processing image ...", 0, 100);
223 }
224
225 catch (IOException error) {
226 buffer = null;
227 errorCleanUp ("Algorithm CT MD: source image locked", true);
228 return;
229 }
Figure 343. PlugInAlgorithmCT_MD.java
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230
231
232
233
234
235
236
237
238
239
240
241
242
243
244
245
246
247
248
249
250
251
252
253
254
255
256
257
258
259
260
261
262
263
264
265
266
267
268
269
270
271
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catch (OutOfMemoryError e) {
buffer = null;
errorCleanUp ("Algorithm CT MD: Out of memory creating process buffer", true);
return;

int totFat = 0;
int totLdMuscle = 0;
int totHdMuscle = 0;
initProgressBar () ;

for (int i = 0; 1 < srcImage.getExtents()[2] && !threadStopped; i++) {
int fat = 0¢
int ldMuscle 0;
int hdMuscle 0;

if ( isProgressBarVisible() )
progressBar.setValue (Math.round ( (float) (i) / (srcImage.getExtents () [2]-1) *
100));

for (int j = 0; j < imgLength && !threadStopped; j++) {
System.out.println (" =" 4 ) g
int index = i*imgLength+j;
if ( buffer[index] >= fatlL && buffer[index] <= fatH ) {
destImage.set (index, 60);

totFat++;
fat++;
}
else if ( buffer[index] >= 1ldmL && buffer[index] <= ldmH ) {
destImage.set (index, 120);
totLdMuscle++;
ldMuscle++;
}
else if( buffer[index] >= hdmL && buffer[index] <= hdmH ) {
destImage.set (index, 200);
totHdMuscle++;
hdMuscle++;
}
else {
destImage.set (index, 0);
buffer[i] -1024;

}

destImage.getUserInterface () .getMessageFrame () .append ("\n\n ***x*kxkkxkkxksx* S1]ce

LIS l 4+ " tOtalS ***************\n",
ViewJFrameMessage.DATA) ;
destImage.getUserInterface () .getMessageFrame () .append ("Number of fat pixels = " +
fat , ViewJFrameMessage.DATA );
destImage.getUserInterface () .getMessageFrame () .append (" Volume = " + (fat*vol) +

" mm”*3\n", ViewJFrameMessage.DATA ) ;

destImage.getUserInterface () .getMessageFrame () .append ("Number of LDM pixels = " +
ldMuscle , ViewJFrameMessage.DATA );
destImage.getUserInterface () .getMessageFrame () .append (" Volume = " +

(ldMuscle*vol) + " mm”"3\n", ViewJFrameMessage.DATA );

Figure 343. PlugInAlgorithmCT_MD.java
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286 destImage.getUserInterface () .getMessageFrame () .append ("Number of HDM pixels
287 = " + hdMuscle , ViewJFrameMessage.DATA );

288 destImage.getUserInterface () .getMessageFrame () .append (" Volume = " +

289 (hdMuscle*vol) + " mm”3\n", ViewJFrameMessage.DATA );

290 }

291

292 destImage.releaselock();

293

294 if (threadStopped) {

295 finalize () ;

296 return;

297 }

298

299 destImage.getUserInterface () .getMessageFrame () .append ("M \n * %%k %k &k &k ko kok kokkokkok ko
300 Totals ********************\n",

301 ViewJFrameMessage.DATA) ;

302 destImage.getUserInterface () .getMessageFrame () .append ("Number of totFat pixels = " +
303 totFat , ViewJFrameMessage.DATA );

304 destImage.getUserInterface () .getMessageFrame () .append (" Volume = " + (totFat*vol) +
305 " mm~3\n", ViewJFrameMessage.DATA );

306

307 destImage.getUserInterface () .getMessageFrame () .append ("Number of LDM pixels = " +
308 totLdMuscle , ViewJFrameMessage.DATA );

309 destImage.getUserInterface () .getMessageFrame () .append (" Volume = " + (totLdMuscle*vol)
310 + " mm”*3\n", ViewJFrameMessage.DATA );

311

312 destImage.getUserInterface () .getMessageFrame () .append ("Number of HDM pixels = " +
313 totHdMuscle , ViewJFrameMessage.DATA );

314 destImage.getUserInterface () .getMessageFrame () .append (" Volume = " + (totHdMuscle*vol)
315 + " mm~3\n", ViewJFrameMessage.DATA );

316

317 destImage.calcMinMax () ;

318 progressBar.dispose () ;

319 setCompleted (true) ;

320 }

321 }

Figure 343. PlugInAlgorithmCT_MD.java
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PlugInCT_MD.java

import
import

plugins.
gov.nih.

PlugInDialogCT MT;
mipav.plugins.*;

//needed

//PlugInFile
import
import

gov.nih.
gov.nih.

mipav.view.*;
mipav.model.structures.*;

import

java.awt.*;
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e}
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26
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28
29
30
31
32
33
34
35
36
37

’lugIn, and

PlugInAlgo

parameters

menting
the
class PlugInCT MD implements PlugInAlgorithm {

rithm requires

correct

ram parentFrame

his is an

Current ]
MIPAV.

imag elImage--t

Can be null.

public void run (ViewUserInterface UI, Frame parentFrame,

if (parentFrame instanceof ViewJFrameImage)
new PlugInDialogCT MD (parentFrame, image);

else
}

}
Figure 344. PlugInCT_MD.java

Pl

ModelImage image) {

MipavUtil.displayError (“PlugIn CT MD only runs on an image frame.”);
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PlugInDialogImageVOIDisplay.java

1 import java.awt.*;

2 import java.awt.event.*;

3 import java.util.Vector;

4

5 import javax.swing.*;

6 import gov.nih.mipav.model.file.FileInfoBase;

7 import gov.nih.mipav.model.structures.ModelImage;

8 import gov.nih.mipav.model.structures.ModelLUT;

9 import gov.nih.mipav.model.structures.ModelRGB;

10 import gov.nih.mipav.model.structures.VOI;

11 import gov.nih.mipav.view.*;

12 import gov.nih.mipav.view.dialogs.*;

13

14

15 /**

16 * Plugin example class for creating a simple, self-contained frame that extends ViewJFrame
Image

17 * Contains a subset of the VOI functions, as well as the message frame contained within the
frame itself

18 * @author linkb

19 &

20 =/

21 public class PlugInDialogImageVOIDisplay extends ViewJFrameImage implements MouseListener,
AdjustmentListener {}

22 [/~ ComSErUCEOES ===mmmmcmmmm e s e s e o s e e e e e e e S e e e e e E e S eSS S E DS S

23

24 /**

25 * Default constructor

26 =/

27 public PlugInDialogImageVOIDisplay (ModelImage image) {

28 super (image, null, null, false, false);

29 init () ;

30 }

31

32

33 /*x

34 * ViewOpenFramelInterface function for opening a model image (result) into a new frame

35 =/

36 public PlugInDialogImageVOIDisplay openFrame (ModelImage image) {

37 return new PlugInDialogImageVOIDisplay (image) ;

38 Al S I

39

40 // Ahkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkhkhkhkhhkhhkhkhhkhhkhhhhhhhhkhhhhkhkhkhkhkhkhhkhkhkhkhkhkhkhkhkhkhkhkxkxkx*

41 // khkkhkkhkhkkhkhkkhkhkhkhkhkkhkhkkhkhkhkhkkkhhkhkk Event Processing RaR Rk kI b b b b b b b b b b b b b b b b i

42 // dkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkhhhhkhhhkhkhkhkhhkhhkhkhhkhhhhhhhkhkkhkkhkkhkkhkhkhkhkhkhkhkhkkkkkkkkk*k

43 public void adjustmentValueChanged (AdjustmentEvent e) {

44 updateImages (true) ;

45 }

46

Figure 345. PlugInDialogImageVOIDisplay.java
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47 Vadd

48 * Closes dialog box when the OK button is pressed and calls the algorithm.

49 &

50 * @param event Event that triggers function.

51 =/

52 public void actionPerformed (ActionEvent event) {

53 String command = event.getActionCommand () ;

54 System.err.println ("command: " + command) ;

55

56 //run through toggle buttons to see if a menu selected one (updates the button status)

57 getControls () .getTools () .setToggleButtonSelected (command) ;

58

59 if (command.equals ("Gaussian blur")) {

60 new JDialogGaussianBlur (this, getActiveImage());

61 } else if (command.equals("Gradient magnitude")) {

62 new JDialogGradientMagnitude (this, getActivelImage());

63 } else if (command.equals ("Open")) {

64 //ViewUserInterface.getReference () .openImageFrame () ;

65 } else if (command.equals (CustomUIBuilder.PARAM VOI DEFAULT POINTER)) {

66 componentImage.setCursorMode (ViewJComponentEditImage.DEFAULT) ;

67 } else if (command.equals (CustomUIBuilder.PARAM VOI POINT.getActionCommand())) {

68

69

70 if
(!componentImage.getVOIHandler () .checkForVOICompatibility (getActivelImage () .getVOIs(),
VOI.POINT, getControls())) {

71 componentImage.setCursorMode (ViewJComponentEditImage.NEW VOI) ;

72 }

73

74 componentImage.setCursorMode (ViewJComponentEditImage.POINT VOI) ;

75 } else if (command.equals (CustomUIBuilder.PARAM VOI LINE.getActionCommand())) {

76

77 if
(!componentImage.getVOIHandler () .checkForVOICompatibility (getActiveImage () .getVOIs(),
VOI.LINE, getControls())) {

78 componentImage.setCursorMode (ViewJComponentEditImage.NEW VOI) ;

79 }

80

81 componentImage.setCursorMode (ViewJComponentEditImage.LINE) ;

82 } else if (command.equals ("SplitVvOoI")) {

83 componentImage.setCursorMode (ViewJComponentEditImage.SPLIT VOI);

84 } else if (command.equals (CustomUIBuilder.PARAM VOI POLY SLICE.getActionCommand())) {

85

86 if
(!componentImage.getVOIHandler () .checkForVOICompatibility (getActiveImage () .getVOIs (),
VOI.POLYLINE SLICE, getControls())) {

87 componentImage.setCursorMode (ViewJComponentEditImage.NEW VOI) ;

88 }

89

90 componentImage.setCursorMode (ViewJComponentEditImage.POLYLINE SLICE VOI) ;

91 } else if (command.equals("protractor")) {

92

93 if
(!componentImage.getVOIHandler () .checkForVOICompatibility (getActiveImage () .getVOIs (),
VOI.PROTRACTOR, getControls())) {

94 componentImage.setCursorMode (ViewJComponentEditImage.NEW VOI) ;

95 }

Figure 345. PlugInDialogImageVOIDisplay.java (continued)
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96 componentImage.setCursorMode (ViewJComponentEditImage . PROTRACTOR) ;

97 } else if (command.equals ("Polyline")) {

98

99 if
(!componentImage.getVOIHandler () .checkForVOICompatibility (getActiveImage () .getVOIs (),
VOI.POLYLINE, getControls())) {

100 componentImage.setCursorMode (ViewJComponentEditImage.NEW VOI) ;

101 }

102

103 componentImage.setCursorMode (ViewJComponentEditImage.POLYLINE) ;

104 } else if (command.equals (CustomUIBuilder.PARAM VOI TEXT.getActionCommand())) {

105

106 componentImage.setCursorMode (ViewJComponentEditImage.NEW VOI) ;

107

108

109 componentImage.setCursorMode (ViewJComponentEditImage.ANNOTATION) ;

110 } else if (command.equals ("RectVOI")) ({

111

112 if
(!componentImage.getVOIHandler () .checkForVOICompatibility (getActiveImage () .getVOIs (),
VOI.CONTOUR, getControls())) {

113 componentImage.setCursorMode (ViewJComponentEditImage.NEW VOI) ;

114 }

115

116 componentImage.setCursorMode (ViewJComponentEditImage.RECTANGLE) ;

117 } else if (command.equals("EllipseVOI")) {

118 if
(!componentImage.getVOIHandler () .checkForVOICompatibility (getActivelImage () .getVOIs(),
VOI.CONTOUR, getControls())) {

119 componentImage.setCursorMode (ViewJComponentEditImage.NEW VOI) ;

120 }

121

122 componentImage.setCursorMode (ViewJComponentEditImage.ELLIPSE) ;

123 } else if (command.equals("LevelSetVOI")) {

124 componentImage.getVOIHandler () .checkForVOICompatibility (getActiveImage () .getVOIs (),
VOI.CONTOUR, getControls());

125 componentImage.setCursorMode (ViewJComponentEditImage.LEVELSET) ;

126 } else if (command.equals ("Rect3DVOI")) {

127 componentImage.getVOIHandler () .checkForVOICompatibility (getActiveImage () .getVOIs (),
VOI.CONTOUR, getControls()):;

128 componentImage.setCursorMode (ViewJComponentEditImage.RECTANGLE3D) ;

129 } else if (command.equals ("LiveWirevOoI")) {

130 componentImage.getVOIHandler () .checkForVOICompatibility (getActiveImage () .getVOIs (),
VOI.CONTOUR, getControls()):

131

132 if (componentImage.getVOIHandler () .isLivewireNull()) {

133 JDhialoglivewire dialog = new JDialogLivewire (this);

134

135 if (!dialog.isCancelled()) {

136 componentImage.getVOIHandler () .setModeLivewire (dialog.getSelection()) ;

137 componentImage.setCursorMode (ViewJComponentEditImage.LIVEWIRE) ;

138 }

139 } else {

140 componentImage.setCursorMode (ViewJComponentEditImage.LIVEWIRE) ;

141 }

142 } else if (command.equals ("NewVOI")) {

143 componentImage.setCursorMode (ViewJComponentEditImage.NEW _VOI) ;

Figure 345. PlugInDialogImageVOIDisplay.java (continued)
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144 int id = (getActivelmage () .getVOIs().size() > 0)
145 ? (((VOI) (getActivelImage () .getVOIs().lastElement())).getID() + 1) -1;
146
147 getControls () .setVOIColor (id);
148 } else if (command.equals ("cutVOI")) {
149
150 if (componentImage.getVOIHandler () .copyVOItoClipBrd()) {
151 componentImage.getVOIHandler () .deleteSelectedVOI (true) ;
152 }
153 } else if (command.equals ("copyVOI")) {
154 componentImage.getVOIHandler () .copyVOItoClipBrd() ;
155 } else if (command.equals("pastevOI")) {
156 componentImage.getVOIHandler () .pasteVOI () ;
157 } else if (command.equals("selectAllVOIs")) {
158 componentImage.getVOIHandler () .selectAl1VOIs (true) ;
159 } else if (event.getActionCommand () .equals ("voiSelectNone")) {
160 componentImage.getVOIHandler () .selectAllVOIs (false) ;
161 } else if (command.equals("deleteVOI")) {
162 componentImage.getVOIHandler () .deleteSelectedVOI (true) ;
163 } else if (command.equals ("BringToFront")) {
164 componentImage.getVOIHandler () .changeVOIOrder (false, VOIHandler.FRONT) ;
165 } else if (command.equals("SendToBack")) {
166 componentImage.getVOIHandler () .changeVOIOrder (false, VOIHandler.BACK) ;
167 } else if (command.equals ("BringContourToFront")) {
168 componentImage.getVOIHandler () .changeVOIOrder (true, VOIHandler.FRONT) ;
169 } else if (command.equals ("SendContourToBack")) {
170 componentImage.getVOIHandler () .changeVOIOrder (false, VOIHandler.BACK) ;
171 } else if (command.equals ("PropVOIUp")) {
172
173 // It appears JButtons don't pass key modifiers
174 // 1if ((event.getModifiers() & ActionEvent.SHIFT MASK) != 0) {}
175 if (componentImage.getVOIHandler ().propVOI (1, false) == true) {
176 incSlice();
177 }
178 } else if (command.equals ("PropVOIDown")) {
179
180 if (componentImage.getVOIHandler () .propVOI (-1, false) == true) {
181 decSlice();
182 }
183 } else if (command.equals ("PropVOIActiveUp")) {
184
185 // It appears JButtons don't pass key modifiers
186 // 1if ((event.getModifiers() & ActionEvent.SHIFT MASK) != 0) {}
187 if (componentImage.getVOIHandler () .propVOI (1, true) == true) {
188 incSlice () ;
189 }
190 } else if (command.equals ("PropVOIActiveDown")) {
191
192 if (componentImage.getVOIHandler () .propVOI (-1, true) == true) {
193 decSlice();
194 }
195 } else if (command.equals ("PropVOIAll")) {
196 componentImage.getVOIHandler () .propVOIALL () ;
197 } else if (command.equals ("BringForward")) ({
198 componentImage.getVOIHandler () .changeVOIOrder (false, VOIHandler.FORWARD) ;
199 } else if (command.equals ("SendBackward")) {
Figure 345. PlugInDialogImageVOIDisplay.java (continued)
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200 componentImage.getVOIHandler () .changeVOIOrder (false, VOIHandler.BACKWARD) ;

201 } else if (command.equals ("SendContourForward")) {
202 componentImage.getVOIHandler () .changeVOIOrder (true, VOIHandler.FORWARD) ;
203 } else if (command.equals ("SendContourBackward")) {
204 componentImage.getVOIHandler () .changeVOIOrder (true, VOIHandler.BACKWARD) ;
205 } else if (command.equals ("VOIProperties")) {
206
207 componentImage.getVOIHandler () .showVOIProperties (false) ;
208
209 } else if (command.equals ("VOIPropertiesColor")) ({
210
211 if (getActivelImage () .getVOIs() .size() > 0) {
212
213 ViewVOIVector VOIs = getActiveImage () .getVOIs() ;
214
215 int i;
216 int nVOI = VOIs.size();
217
218 for (1 = 0; i < nVOI; i++) {
219
220 if ((VOIs.VOIAt (i) .isActive() == true) &&
221 ((VOIs.VOIAt (i) .getCurveType () == VOI.CONTOUR) ||
222 (VOIs.VOIAt (1) .getCurveType () == VOI.POLYLINE) ||
223 (VOIs.VOIAt (1) .getCurveType () == VOI.POINT) ||
224 (VOIs.VOIAt (i) .getCurveType () == VOI.LINE) ||
225 (VOIs.VOIAt (i) .getCurveType () == VOI.PROTRACTOR))) {
226 break;
227 } else if ((VOIs.VOIAt(i).isActive() == true) &&
(VOIs.VOIAt (1) .getCurveType () == VOI.ANNOTATION)) {
228 MipavUtil.displayInfo ("Double-click annotation to change properties");
229 i=-1;
230
231 break;
232 }
233 }
234
235 if (i == nVOI) {
236 MipavUtil.displayError ("Please select VOI");
237 } else if (i == -1) { // there was an annotation selected, do nothing
238 } else {
239 componentImage.getVOIHandler () .showVOIProperties (true) ;
240 }
241 } else {
242 MipavUtil.displayWarning ("Image has no VOIs!");
243 }
244
245 }
246 }
247
248 [**
249 * Can handle actions for the resizing of the frame
250 =)
251 public synchronized void componentResized (ComponentEvent event) {
252
253 }
254
Figure 345. PlugInDialogImageVOIDisplay.java (continued)
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255

256 [

257 * Override MouselListener functions to prevent MouseEvent catching in ViewJFrameImage
258 =)

259 public void mousePressed (MouseEvent e) ({}

260 public void mouseReleased (MouseEvent e) {}

261 public void mouseEntered (MouseEvent e) {}

262 public void mouseExited (MouseEvent e) {}

263 public void mouseClicked (MouseEvent e) {}

264

265

266 J=%

267 * Initialize the frame using a lut (can be null)

268 * (@param LUTa the ModelLUT

269 * @throws OutOfMemoryError

270 Y

271 private void init () throws OutOfMemoryError {

272

273 try {

274 setIconImage (MipavUtil.getIconImage ("davinci 32x32.gif"));

275 } catch (Exception error) {

276 Preferences.debug ("Exception ocurred while getting <" + error.getMessage() +
277 ">, Check that this file is available.\n");

278 }

279

280 setResizable (true);

281

282 // initialize logMagDisplay

283 this.LUTa = initLUT (imageA) ;

284

285 initResolutions () ;

286 initZoom() ;

287

288 int[] extents = createBuffers();

289

290 initComponentImage (extents) ;

291 initExtentsVariables (imageB) ;

292

293 // create and build the menus and controls

294 controls = new ViewControlsImage (this); // Build controls used in this frame
295 menuBuilder = new ViewMenuBuilder (this);

296

297 // build the menuBar based on the number of dimensions for imageA

298 menuBarMaker = new ViewMenuBar (menuBuilder) ;

299

300 //create a custom menu bar using Vectors of UIParams

301 JMenuBar menuBar = new JMenuBar();

302

303 //add pre-defined UIParams to the vector (will be added to both menu and toolbar)
304 Vector<CustomUIBuilder.UIParams> voiParams = new Vector<CustomUIBuilder.UIParams> () ;
305 voiParams.addElement (CustomUIBuilder.PARAM VOI DEFAULT POINTER) ;

306 voiParams.addElement (CustomUIBuilder.PARAM VOI POINT) ;

307 voiParams.addElement (CustomUIBuilder.PARAM VOI_ELLIPSE) ;

308 voiParams.addElement (CustomUIBuilder.PARAM VOI RECTANGLE) ;

309 Vector<CustomUIBuilder.UIParams> algoParams = new Vector<CustomUIBuilder.UIParams>();
310 algoParams.add (new CustomUIBuilder.UIParams ("Gaussian blur", null, null));

311 algoParams.add (new CustomUIBuilder.UIParams ("Gradient magnitude", null, null));

Figure 345. PlugInDialogImageVOIDisplay.java (continued)
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312 menuBar.add (menuBarMaker.makeCustomMenu ("VOI example", voiParams));

313 menuBar.add (menuBarMaker.makeCustomMenu ("Simple algorithm menu", algoParams)) ;
314

315 //create a simple toolbar (rather than the default ViewJFramelImage specific toolbar)
316 //buttons will be added to the toolbar with the function call .addCustomToolBar ()
317 controls.buildSimpleToolBar () ;

318

319 controls.addCustomToolBar (voiParams) ;

320

321 setTitle();

322

323 JPanel centerPanel = new JPanel ()

324 centerPanel.add (componentImage, BorderLayout.CENTER);

325

326 // The component image will be displayed in a scrollpane.

327 scrollPane = new JScrollPane (centerPanel, JScrollPane.VERTICAL SCROLLBAR AS NEEDED,
328 JScrollPane.HORI ZONTAL_SCROLLBAR_AS_NEEDED) 2
329

330 JSplitPane splitPane = new JSplitPane (JSplitPane.VERTICAL SPLIT, scrollPane,
331 ViewUserInterface.getReference () .getMessageFrame () .getTabbedPane () ) ;
332 splitPane.setDividerLocation (350) ;

333

334 getContentPane () .add (splitPane) ;

335 scrollPane.setBackground (Color.black) ;

336

337 setBackground (Color.black) ;

338

339

340

341 // MUST register frame to image models

342 imageA.addImageDisplayListener (this);

343

344 if (imageB != null) {

345 imageB.addImageDisplayListener (this) ;

346 }

347

348 windowLevel = new JDialogWinLevel[2];

349

350 this.setLocation (100, 50);

351

352 setDefaultCloseOperation (JFrame.DO NOTHING ON_CLOSE) ;

353 pack();

354

355 scrollPane.setPreferredSize (new Dimension (800,800)) ;

356 scrollPane.getVerticalScrollBar () .addAdjustmentListener (this);

357 scrollPane.getHorizontalScrollBar () .addAdjustmentListener (this) ;

358 scrollPane.addComponentListener (this) ;

359

360 setSize (1000, 750) ;

361 // User interface will have list of frames

362 userInterface.registerFrame (this);

363 this.updatelImages (true);

364 addComponentListener (this) ;

365

366 this.setJMenuBar (menuBar) ;

367 getContentPane () .add (controls, BorderLayout.NORTH) ;

Figure 345. PlugInDialogImageVOIDisplay.java (continued)
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368 this.addWindowListener (new WindowAdapter () {

369 public void windowClosing (WindowEvent we) {
370 System.exit (0) ;

371 }

372 }) i

373

374 setVisible (true);

375 } // end init ()

376

377

378 /3%

379 * Sets the title of the frame

380 =)

381 public void setTitle() {

382 this.setTitle ("Simple Image Frame: " + imageA.getImageName());
383 }

384

385

386

387 }

Figure 345. PlugInDialogImageVOIDisplay.java (continued)
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